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About PDF to FlashBook Pro

PDF to FlashBook Pro is a much professional
program to help you convert ordinary PDF files into
stunning booklets with amazing page-flipping
animations and sound! Besides original classical
Flip PDF features such as adding background
images and sound, PDF to FlashBook Pro also
provides more powerful and professional
functionalities, like embedding video, audio and
links into your flipbook pages, exporting defined
templates and settings to theme for later easy
using, using command line to automate the
creation of the flash eBooks without opening the

Windows desktop application.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.
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Product features

9.

Convert PDF to Adobe®© Flash® based page-flipping eBooks.

Output in 4 different formats: HTML, EXE, Zip and Burn to CD.

HTML allows you to upload to a website to be viewed online.

EXE and Zip allow you to send to your user by email to be viewed on

their computer.

Burn to CD allows you to burn to disk so you can send your user
physical media for viewing on their computer.

Preview the output effect instantly.

Batch convert multiple PDF files to a single or multiple page-flipping
eBooks.

Import bookmarks (outline) with PDF, and edit them manually.

Including hyperlinks with PDF, include web link, page link, email link.

10. Import text and search imported text with user-defined search terms.

11.Provide multiple templates (default provided or download from

website).

12.Set eBook size, choose landscape or portrait.

13.Watermark your page-flipping eBook using text, images, dynamic

date/time and more.

14. Define titles, keywords and other metadata.
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15. Define titles, icon, window size for EXE page-flipping ebooks.

16. Define book margin size manually.

17.Add encryption to protect created page-flipping eBooks.

18.Retain the book to center or not.

19. Insert background music, always play or define times.

20.Set background color, image or flash.

21.Set book reading from right to left (such as Arabic).

22.Choose hard cover for eBooks.

23.Set page-flipping time to be manual (reader-driver) or automatic (as
you design).

24. Customize toolbar buttons to set permissions for downloading, printing,
sharing and more.

25.Set colors for toolbar, book cover, book shadows, bookmarks and more.

26.Set font color, type for windows and bookmarks.

27.Set scale for zoom-in function.

28.Set control bars to "show" or "hide" in full screen.

29. Define language for flash.

30. Edit pages with links, videos, flash or sound files.

31.Export and save settings for future uses.

32.Save themes to make future use easier.

33.Save current files and settings as project.
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34.Provide command line version.

Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:
1. Drag the corner, click page shadow or use arrow keys to flip a page.
2. Input login password to view eBook content.
3. Auto-view flipbook repeatedly.
4. Pre-loading of pages allows first pages to open quickly, viewers does
not need to wait until all pages have loaded.
5. View page thumbnails.
6. Use button to control page, such as Previous, Next, First, Last etc.
7. Flip pages automatically.
8. View page-flipping eBook full screen.
9. Search whole eBook.
10. Print out the whole eBook or a range of pages directly.
11.Download the uploaded page-flipping eBook from web site directly.
12.Double-click to zoom in or zoom out.
13. Links are still "live" and can be clicked to view after zooming in/out.
14.Share eBook URL via email.
15.Turn on or turn off the page-turning sound.

16.View video, flash or play sound file inserted in the pages.
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17.0pen to a certain page in Browser by adding a suffix like this:

index.html?pagelndex=4.

Quick Start

N

v

1. Launch the application via the desktop shortcut =l

 1.Add Flie
2. Click the "1. Add File" Tab icon “' to enter

into Import PDF interface;

3. Click L_#®**= |icon to choose PDF file from your computer;

4. Click icon to enter into template setting

interface;

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and

Apply Change
then click the "Apply Change" icon a ;

3. Publish
6. Click "Publish" Tab icon “i to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take

Y @-nm

as example;
8. Click | #2"*= |{5 set Output Folder as "C:\flipbook", input File Name

as "demo";
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You can open the "flipbook" folder in "C:", there are three files in this folder:

5 @

files book.swf dema.html

Open the "demo.html" file to view your created pOOage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

& demo - Windows Internet Explorer E=neey x|
OO - |i] Ciflipbook\demo.htmi — [ 42| % |[E 8ing P
<o Favorites | 7 :
| @ demo [ % v B v 0 o v Pagev Safetyv Tookv @+ 7

ﬂlﬁu\

P

FLIPBUILDER COM Fur PDF PrO

@ Internet | Protected Mode: Off 5 v ®10% -

Interfaces

There are some main interfaces you will see while using PDF to

FlashBook Pro as below shows: Application Options, Import PDF,
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Template Settings, Edit Pages, Language Option, Export Theme, Output,
Batch Convert and Command Line.
You can enter into each page to get clear instructions for every detail

option.

I. Application Options Interface

Render Engine Option

PDF to FlashBook Pro provides 3 different render engines for you to create higher
quality page-flipping eBooks, click "Options->Application Options" to enter into
"Render Engine" interface:

Frerder Engene

Flease seleche a render engine for the conversion

Ediks
EL"."F
F
i
GPL Ghostsript Doiwload Ghostecript
F
[LTH ]

@ frmesr Library

SVWiF: Miuch legble characters, smaler output sire
. Ghostsomipt: Higher cofor ransfer gualbty

Inner Library: Faster convert speed

Lox ] [ coe

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
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Inner Library: Faster convert speed
(Change option when PDF imported failed)

Il. Import PDF Interface

1. Add Flie 2. Style | 3. Publish
J ]
Import PDF
C:‘u,l_lsers'-;B.dminisﬁ'amr'npeskmp'l,lzz.pdf Browse.. | | Open it
Page range to import Watermark
@ All pages =
(") Custom rage: Example:1,9-21,30 " o
s = Set Watermark
|| Quickly import {Only import 10 pages to initial preview)
Pages quality and size
Quality And Size: lHigh quality large file size V]

M High values produce better page quality but require more disk space and more time to download.

Options

[7] tmport bookmark |+/| Import links | |Enable search || Detect wide pages

Panel Description:

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Open it View content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©alpagEs oo hvert all pages to page-flipping eBook;

@ Custo 2125 E ler1,3,5,9-21 .
EEe xampie:1, Convert defined range page;

[¥] Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages
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3. Watermark

Add image or text watermark to flipping pages.

W ing Watermark . . .
Appiying Check this option first to choose default stamps or add new ones:
[ et wotermark e e il
A Add Text Watermark |
Tex! Mpyme
Bame: Text Watermark
Taxl - Page-fipong ellook Macror -
'lmms-’ﬂk
Eont: ﬂ"rﬁ;;;;_; /| Embesided Fan
e oo I
st 7] ok Pltac | nderiee
Teact Lajyout
Layout: [Fix - &) s badground
Elmeste o [no? |2 s 1007 e
Postion nmargrs  Margs
v w Husenm e
| = uf -
= 51} m] - E,.'m," » e Page-flipping eBook
Text Effect
Coadty: 0% T %
= . Rt 9 T Deges
& Edit /’ - |
Inches -
& Add text stamp :
B Add image stamp-_iasimege watemark
& Delete Image Nae
Hame: [mage Waiermark
#  Move up o sl =
widd: % i Heghtt @ i
Bt to marges E [ Eteich 1o margee E
Trmage Effect
Dpacty: 0% : I 1D0%
Rowtan: 0 o gegres | a5 badkground
Postorinmargns  Margns
e | e %
Bomel emw B mwmw B
= { 8]} = Botom: 7m 5
r{il
[ imeters -
Lo | [ oma |

4. Page Quality
There are five types of "Quality And Size":

iality large file size

High quality large file size
Medium guality medium file size
Low guality small file size
Lower guality smaller file size
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5. Other Options:

[l use first page's widitrand height s page proportion Select this option to use first page's
proportion as book proportion, or you can define in Template Setting interface;

[} tmport bookmark If your PDF file contains bookmarks, check this option to use in output
page-flipping eBook;
/] 1mpart inks If your PDF file has links, check this to enable in flipbook;

Enable search ok this option to enable search functionality in created flipbook.

At last, click [ImPertNow | 06n to enter into template setting interface.

lll. Template Settings Interface

- 1
[ FLF o FlsshBock Stendsss Unregizsered — FIF <o FlashBock Standerd Overviss [
2 b - e o = a1 5 . x - e . =
File Convert Options Halp
1. Add Flie J 2. Style J 3. Publish J

Design Setting Bookmark:

Apply Change .
BToolBars Settings | e B0
. e
u ;- Themes - ElHome Button
Catalog: | Home Button Visible  |Hide =
Templates i PROEARL
Classical B
Spread Ful i
i ERBUREN e HEE
ElPrint Config
Print Enable Mo

Print Wartermark File
.. BlDownload setting |

‘Sound Lonps‘ - -1
ElZoom Config
s COOMEVENERIE :

PDF to FlashBook Pro provides three different templates at present: Classical,

Float and Spread.
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Each template contains some unique settings, the below instructions will

show you details.

The design setting interface contains below main parts:

Choose Template
Book

Sound

Tool Bar

Initial Show
Bookmarks

Links

Language
Security Settings
Font

Panel Description:

1. Choose Template

Panel Description:

i Themes
Catalog:
Templates
Classical
Spread
Click " icon to select templates from below interface:
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Blank,

_ BottomMargn |10

_ RightToleft  No
Flipping Time 0.6

(1) Book Title (only can be set in Float Template)

Customize book title for showing on the top of your flipbook.

Copyright 2010 by FlashBookMaker.com
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(2) Hide Book Frame Bar

| Hide Book Frame Bar Yes l]

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center
| Retain the book to center |Yes B |

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for
embedding special background image, such as advertisement or company log.

(4) Book Proportions

ElBook Proportions
. Pegeidth  |1052
. FPageHeight . |1508

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

g Margin ........ SRR ‘

— pﬂargin

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

Copyright 2010 by FlashBookMaker.com
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(6) Flash Window Color
B

Flash Window Color | Ml0x00001 =]

Bottom A

This color will be applied on all flash windows, such as the book window, "Help" window,

"Print" window and so on.

(7) Page Background Color

... Page Background Color | 10xFF8040.

When load pages, or if the page number of your PDF file is odd, then the page (the last page)

will show with the "Page Background Color".
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(8) Page Shadow

L T

... leftpageShadow 150

....Rightpage Shadow 125
Page Shadow Opadty 0.5

Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config

A. Background Color:

ElBackground Config
BlBackaround Color [
Gradient Color A |CJoxFFFFPF
Gradient Color B | l0x000000
Gradient Anale |90
e Gradient Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.

B. Background Image setting in Classical and Spread templates:

HBackground Image
Image File E\L (7).ipdF
Image position Scale to fif

Click the icon n [ to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

C. Background Image setting in Float template:

Copyright 2010 by FlashBookMaker.com
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_ BlBackground Image

| Outer Image File E:\Program.. |

E:'\Program..,

Image position Scale to fit
|Scale to fit |

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right

(10) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

| hjght"To Left |Yes

(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover |'Yes

Copyright 2010 by FlashBookMaker.com
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(12) Flipping time
Flipping Time 0.5 Sets page flipping time in seconds according to your

needs. (Recommended second value is 0.6)

3. Sound Panel

ElSound
Enable Sound |Enable |
Sound File nple3.mp3) _J
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click "z|" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

4. Tool Bar
SEE L AT
Tool bar Show
~ Icon Color |CloxffH
[ Zgom Canfig e
Print Enable Yo
‘Search Button [Shaw

__Seard.w Hig:||.'|_|i-gh1:- C.q:lg.r__ | L1 0xfftfD IZI .
HDownload setting

. FulSoeenButton |shaw
Full Screen Without Tool.. [No
Help Button |Shaw

[HIShare Button

MEHomeButton | .

2ok e |
Tool Bar on top Falze

(1) Tool bar (only in Classical Template)

Tool bar Shaw | Show or Hide Tool bar in created flipbook.

(2) Icon Color

Icon Colar | Jowrrrr =]
7 QA =

Copyright 2010 by FlashBookMaker.com
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(3) Zoom Config

BzoomConfig |
ofeominenable o Yes
Zoom Scale 1.5

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

(4) Print Enable
Print Enable Yes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
& Pnnt '

= Print A1 Pages
_) Print Current Page

) Print Renge
Example; 2,5,3-26

£ Print

(5) Search Button
Search Button Show
Search Highlioht Color | [C]OxfO0

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:
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(6) Download setting

ElDawnioad setting
Download Enable Yes 5
[ Download URL 3DFDemo. pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like "http://www. FlashBookMaker.com/FlipPDFDemo.pdf" or
relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the
PDF to the same path).

Then readers can click the icon n to download your uploaded PDF file directly.

(7) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen
Button" option: Full Screen Button Show

[
. . .ﬂ . . . . . o 1] n
Then you can click icon to view flipbook in Full Screen, click icon or "Esc

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):
Full Screen Without Toal.. | Yes

(8) Help Button
To show tips about viewing flipbook, you can set "Show" in "Help Button" option:
Help Button Shaw

Then you can see the button and click to get the tips as below:
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J Double click to zoom in or out

J Drag the page corner to wview

(9) Share Button
If you want your flipbook viewers to send the link to their friends or clients, you can add a

share button in your flipbook for readers to send out your flipbook link immediately:
Hshare Button

Share Button Shnw
Email Subject Rear my fii...
Email Body fink}

When the viewers click the share button E, they will enter into the Email interface with
the link of your flipbook in the Email body.
(10) Home Button

You can add a Home Button m on the toolbar to enable readers back to your home
page after viewing your page-flipping eBooks:

_BlrHome Button ol
... Home Button Visble  [Show
_ PagelRL ~ ihtip:ffip...
Open Windaow ==

(11) Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

T
R enhn e D
Play Count -1

i At ﬁ||:. wh;ailq 513rt|_|p YES.. e bk

(12) Tool Bar on Top (set in Float Template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
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"Tool Bar on Top" as "True":

Tool Bar on top |True

5. Initial Show (set in Float/ Spread Template)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just

select "Bookmark" or "Thumbnails" in this option:

", ] Initial Show | Thumbnails ‘ﬂ

For Example, select "Thumbnails":

Then you will get flipbook shown with below initial interface:

furmoes oo FUP PDF PRO

6. Bookmark

| ElBookmark:

Font color W 0000000
Background color e SEAFF e
Estkoround sibha i

Always Show Bockmark | True

Fanle Position Left

age I FUIPELILOEE COM Fur PDF PRO

1 s L T

Ttle:  Other products

Page: &
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In "Design Setting" panel (only in Classical Template, in other templates, the colors will be
adjusted automatically based on your defined flash window color), you can set "Font color",
"Background color", "Background alpha" (refers to the background opacity, value interval:
0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/
False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF"
interface, or you want to create new bookmarks for your flipbook, you can add bookmarks
even sub-bookmarks here, click "Add" icons and then input "Title" and "Page".

When click the bookmark button , it will popup the bookmark panel immediately, and

click on those bookmarks, it will jump to the defined page automatically

7. Links

BILnkS o

... Mouse over color

L bnkalpha 8z

...Open Window  Blank
Enable after zoomingin  |Enable

Create your professional fipping book with POF files

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

8. Language

|_Language |English -|

You can set language for showing tools or tips in your created flipbook, and here is the
specialized instruction page for setting the "Language Option".
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9. Security Settings

[ Security Settings Single Pase ]

If you want to protect your flash books with passwords, you can click "..." icon to enter into

L

teote:
Srgle Password oprtion mesns fhat users need e passward o view the fash ook

Exciude Front Papes option ks to set a page number, ol atier pages ant be
vieved vethout inputing password.

Senurdy Tyoe
ey Sacurily
1 .
% |
"\ & Srve Paddwnid: 127458
Protect Fage Rangs
& Pages
0 Exclude Front Pages ]

T Gase

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)

10. Font

F3

Product features

| Fontoor N
 Button Font
. |Window FontCalor

| WindowFont
_|Bookmark Fonit Color
Bookmark Font

Copyright 2010 by FlashBookMaker.com
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If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set
font types and colors in Font Panel.

11. Export Theme

If you want to save the current template settings as your own style template for later uses,

antas??'ﬂne
you can click "Export as Theme" button| & to storing all current template

settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface.

IV. Edit Pages

Now you can use PDF to FlashBook Pro to edit imported pages directly, no matter you want to

add link, video, sound or image file.

Edit Pages. |
Just click "Edit Pages" button| rl

to enter into the editing interface:

You can insert links, images, sound files and movies to the pages as you will.

1. Add Link:
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Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:

Link Properties

Over Color: . Ovar Alpha:

O Down @ Up @ Move

Down Color: - Down Alpha: B & Over ® out

Mormal Color: MNormal Alpha:

® Gotopage  Openalink ® Call Javascript function

URL:

Link Target: m m w

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text.

Just make sure the parameter you set in "Function" can be called in from HTML page.
Example:

Check "Call Javascript function" as action type, then input Function as "testLightBox("Hello, this is
a test"):
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m @ Up ™ Move

™ Over ® Cut

=

Goto-page ™ Open alink @ Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):

<head>
<title>PDF-BenU brochure 2010-100dpi</titles
<meta http-equiv="Content-Tvpe™ content="text/html; charset=uti-8" />
<meta name="Keywords™ content="" /3>
<meta name="Deacripticn" contenc="" />
<meta name="Generator™ content="[Flip PDF wersion 3.0] at http://flipbuilder.com/" />

LI— In S to =limd faul oa nd set height of the

£3tyle type="text/csa™ media="acreen">
hitwl, bsdy | height:100%; )
body { margin:0; paedding:0; overflow:auto; text-align:center;
background-color: #LLLLEf; )
#flashContent | displayv:none; }
<fatyle>

<{script ctype="text/javascript™>

¥ - -
“function testLightBQ%IstrFromElash){

do the things you want here!
w
glert (strFromFlash) ;
}
<fscripty>

2. Add Movie:

Click icon and then draw a box like below on the page you want to insert FLV movie:
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-26-



| :H

PDF to Professional Page-Flipping eBook Utility
User Document

Play Movie:

Mone
Stop Movie:

When page is viewed

When page is off viewed

3. Add Sound:

. : | , .
Click the icon to draw sound box and then select sound file, set other options:
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Sound Properties

Play Sound:

Stop Sound:

4. Add Flash:

Click icon . to insert SWF flash into your defined area of flipbook page:

?.
After adding links, flash, movie or sounds, you can click the icon- to save the settings and

back to the template setting interface.
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V. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:

. EI Language Settings ﬁ

fou can new or edit & language for the Aach flipping book
meLabledwaJmhﬁmsm;mmatmbemdawdnmm
] The language will be st in the fash template settings

Language Home:  (Crnese v) [# tentooguase| | Kpoele | (B sevens.| | Tioed. |

Language Settings

Label Labled A | eeEE)
Frrst Button B |
Next Page Button T—m = |
Last Button HE—m |
Pravious Page Sutton Bi—51

Dowinload Button T#

Print Button $TEN

Search Button oS

Book Mark Button B

Help Button &

Enable FulScreen Button &R

Disable FullScreen Button BE

Gl Oy Bk on=S il

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

Language Mame: im ish c!']

Arabic
Chinese
£ ||l
French
Greek

You can also add other language for your own uses:

E.-N
1. Click the button [ hiew La”g”agEJ and define name for the new language:

Copyright 2010 by FlashBookMaker.com
-29.



PDF to Professional Page-Flipping eBook Utility

User Document

Click "OK" to save the new language in the list;

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":

Language Settings

Label

Kext Page Button Mext Page
Last Button Last I Edti Language Item
Previous Page Button Previous pe —————————
Dowerload Buttan Dowriad || BEtLEmRage Strig |
Prink, Button Print
Saarch Button seareh ||  Lebeli  FrstButton
Book Mark Button Boak Mark
Help Button Help |abeled:  Presdére|
Enable FulSoreen Button Enabla Fulls
Dizable FullScreen Button Disable Fuld

|_Sou e e Bugbbne Send Dim I

| soveandegtnest | |

[

Cancel

Joe

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable Fullscreen Button

o imid P Bakbam

Labled

Premigre

Page suivante
Derniére

FPage précedente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
| o Smamd

4 Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load..,
Load language file saving before for current using:

-30-
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a Apply Change

After setting template and language, click icon to
apply the settings.
VI. Output Interface
[l PDF o FlssiBook Standsrd Unregistered — FOF 5o FlashBook Stendard Ovesvier PRI
File Convert Options Help
1. Add Flie 5 2. Style J ' 3. Publish i‘
4 4
Qutput type
D ocam Ot o e e O
[¥] Also Make Mobile Version  Make output page-fiipping eBook works on iPad, iPhone and Android mobile devices
@ How to make created eBooks available for others online?
Path
Output Folder: Ci\Jsers\administrator \Documents Browse. .. Open
File Mame: index -html
Options
HTML Title: {4 Advanced
" /Bum to CD
Options
CO Writer [O:I:O,G: PLDS  DVD-ROM DH-16D55 VD15 X
Disc tithe:
[] Make it sutomatically play the fipbook in €O
Output types:

1. HTML

3 ® =l

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo _g ﬁdvanced]

Set Keywords, Description or even Script in the below interface:
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|g| Advanced Settings ﬁ
HTML Advanced Settings |
HTML Meta Settings
Tithe: demo

Keywords:  pdf, fipbook, page-fipping, eboak, online, website, fiash, background, music

Description:  This page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts
You can put some tracking
code sudh as Google
Analytics here.
Need dosed<saript>tag)
[oome
2.ZIP
Bi @z
]

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon: &

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

files

Ik‘?ﬁu:ler‘rm.htrnl

bunk.swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

T

demuo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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"J Advanced Settings ﬂ‘
Exe Advanced Settings
Exe Windaw Info

Caption: dema

eors [ (e | [ et |
Window Size Option
) Mamized | Custom Size

@ Full Soreen

(o ] [ e |

[¥]Burn to €D

You can even burn the output flipbook to CD:

CD Writer [0: 1:0;G: PLDS  DVD-ROM DH-16D55 VD15 'I

Disc title: |Page-Flipping eBook

[¥] Make it automatically play the fipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
C t
"Disc title", at last click button to output flipbook in your defined type.

VIl. Batch Convert Interface

‘J Batch Convert
1 Add POF Documents

A AddFies || Add Eolder

B =
S, Clear M
Name Path
A=Fip POF
JxFip Priniter
S=Flp Word

E:'\Usefid DoaumentsPOFs i POF.pdf
Er'iseful Documents\POF s Fip Prnter. pdf
E:sefid Doscuments POFs Fip Word.pdf

57 Settings
| OutputSettings [OF Setings |

Output type

P o @ o
Path

e
_:'&Q B exe
Oytput Folder: C:\Users\idmeistr ster Deskiog | frowse.. || oOpen: |
File Mama: | [POF Filehame) w | gxe | Filo Nome patiems  (FOF Author)'s << [PDF Title '
Fip POF
| Optiaes
| Caopen:  {POF Tite} ¥  fevanced
Microsoft Word - demod. docx

| Merge Al FOF Fikes to One FipBook

-} Convert to Flash

13
. Convert to Flash

Panel Description:
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1. Add PDF Documents
s AddFiles |

Click this icon to add PDF files from computer;

:a_sgjnddﬁolder| . . S .
[EE Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

% Remaove aﬂ Clear all -@ Move Lip % Move Down

2. Settings

(1). Output Settings

i. Choose Output Type

Output type

D oo

ii. Choose Output Path

Path

Qutput Folder: CiWsersVAdministratorDesktop I l Browse... H open ]

You can also define output name pattern with FileName, Title, Subject and so on:
File Mame: L'r_]

{PDF Title}
{PDF Subject} ‘

FDF Author
{PDF FileName!

And after defining the File Name, you can preview the result example below:

File Mame: {PDF FileName} Flipping Book

Flip POF Flipping Book

iii. Define Output Option

Options
Caption:  {PDF FileMame} - “h &c_luam:\ed|

Flip PDF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:
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EJ Advanced Settings ﬁ U Advanced Settings ; ﬁ

HTML Advanced Settrgs
ML Mata Sattings
Trde: deme
Eeywords:  pdf, fiobock, page-fiaong, ebock, orilng, website, fash, badkgr tund, musc
Descrioton: s poge-fippng ook shows you the sturming flash effect on POF pages, 8
Add Sorpls

Tou <an put some Tadkng
code such 85 Google

iv. Merge All PDF Files to One Flip Book

[¥1erge All POF Files to One FlipBook:

(2). PDF Settings

i. Page Range

The Page Ranges to Import
71 All pages

Example: 1,9-21,30

| | Exe Advanced Settings

Exe Window Info

Caption:  dema
von: TR |

Window Sie Opbon
Mavamrad

@ Full Soreen

You can convert "All pages" or just "Custom range";

ii. Watermark
Watermark
L Place a custom text or image
‘ - Watermark{Stamp) to the file{s)

Refast |

Click "Set Watermark" icon to enter into "Watermark" interface:

Cystom Se
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= B

Cption - “
Watermark
V] Applying Watermark
Watermark Mame Type o
N Y Text - cONFIDENTTAL Tt
[T A Text -Fivar Text s
7] A Text - COMPLETED Text lis!
[T A Text -oRaFT Text
[T] A Text - FOR PLBLIC RELEASE Text &
M [ A Text - INFORMATION OMLY Text 55,
[] A Text - HOT FOR PUBLIC RELEASE Text
[T A Test -nOT APPROVED Text | 5 :
N [C] A Text - Company(Tie) Text 5
7T A Text-L0GO Jeft-top) Text % |
[T A Text -LOGO (Right-Top) Text
] A Text - LOGO (Left-Bottom) Text o
[] A Text -LOGO (Right-Bottom) Text
[ A Text - Dynamic - (3te) Test
[7] = tmage - LOGO image - |
! o« | [ conce |

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

High gualil

e o ] o = .
large file size
Mediurm guality medium file size
Low guality small file size
Lower guality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

[l use first page's widitrand height s page proportion Select this option to use first page's

proportion as book proportion, or you can define in Template Setting interface;

Wi ook ¢ your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

[Vi1mport links If your PDF file has links, check this to enable in flipbook;

[V|Enable search o ok this option to enable search functionality in created flipbook.
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. ._ Convert to Flash
At last, click icon to batch convert listed files together.

VIIl. Use PDF to FlashBook Pro in Command Line

You can also use PDF to FlashBook Pro in Command Line.

PDF to FlashBook Professional Command Line Usage:
PTCMD.exe [Options]
-f<PDF File> The source PDF file.
-o<output folder> Specify the folder for the output files.
-t[html|zip | exe] Output type. Default is html.
-n<OutputFileName>  Specify the name for the output file.

-c<caption> Caption for HTML or EXE.

-s<Flash settings> Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].
<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.
<txt_settingfile path> is the file that you export
with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)
Count be 5,4,3,2,1.5 specify the higher quality larger file

-g<import quality>
size;1 specifies lower quality smaller file size.(default:4)
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-R<GS|SWEF|LIB> Render engine options. (Default: GS, Ghostscript render
engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)

-I<Y|N> Import links yes or no. (Default: Y).

-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)

-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.

-w<window size> Specify the size of exe window.
Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -o0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:
PTCMD  -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -tzip  -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:
Success
Input file not found
Parameters are invalid
Failed to load PDF
Failed to import bookmarks
Failed to import links
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Failed to import searchable information
8: Failed to save the output file.

License Agreements

All copyrights to PDF to FlashBook Pro (the Software) are exclusively owned by
FlashBookMaker.com. For more information, visit our website at
www.FlashBookMaker.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.
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Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.

How to Order

Order Online (http://www.FlashBookMaker.com/flippingbook-maker-pro\index.html) or
Order Toll Free 1-877-353-7297 (When you order toll free just give the operator the product
number of the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)

4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Copyright 2010 by FlashBookMaker.com
-40-



| :H

| 11

\/}3 PDF to Professional Page-Flipping eBook Utility
: User Document

Want to custom the program or have other questions about purchase?
Contact us at support@FlashBookMaker.com .

Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here: http://www.
FlashBookMaker.com/

2. Learn tutorial about PDF to FlashBook Pro

We publish a video tutorial which shows you the easy procedure of dealing with PDF to
FlashBook Pro, you can view this video to quickly handle the stunning tool:
http://www.FlashBookMaker.com/flippingbook-maker-pro/flippingbook-creator-pro.swf

3. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
support@FlashBookMaker.com, we will respond you ASAP.
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